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NI Switches Getting Started Guide

For PXI and SCXI™ Switch Modules

This document explains how to install, configure, and set up National
Instruments PXI and SCXI switch modules. This document covers the
NI-DAQ 7.x software relative to NI switch modules. For a more detailed
explanation of NI-DAQ 7.x, refer to the DAQ Quick Start Guide for
NI-DAQ 7.x available on the NI-DAQ 7.x Device Documentation CD.
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Conventions

»

> @

bold

italic

monospace

monospace italic

The following conventions are used in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

The ¢ symbol indicates that the following text applies only to a specific
product, a specific operating system, or a specific software version.

This icon denotes a tip, which alerts you to advisory information.
This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and information on hardware labels.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Ttalic text in this font denotes text that is a placeholder for a word or value
that you must supply.

Safety and Compliance

Refer to the Read Me First: Safety and Radio-Frequency Interference
document for important safety and compliance information.

@ Note Refer to the specifications document included with the switch module for additional

safety informat
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Related Documentation

The following documents contain additional information about your switch
module and the APIs used to program them. The documents are available
in electronic form at Program Files»National Instruments»
NI-SWITCH»Documentation or Program Files»National
Instruments»NI-DAQ.

»  Specifications document for your switch

* NI Switches Help contains technical and programming support for
your NI switch module and the NI-SWITCH 2.x API

*  NI-SWITCH Instrument Driver Quick Reference Guide contains an
API overview and function/VI overview

*  Read Me First: Safety and Radio-Frequency Interference includes
safety and compliance information

e DAQ Quick Start Guide contains additional information about
NI-DAQ 7.x, the relationship between Traditional NI-DAQ and
NI-DAQmzx, and a complete list of supported modules. Available
on the NI-DAQ 7.x Device Documentation CD.

*  NI-DAQmx Help contains information about programming your
switch with the NI-DAQmx API

*  NI-DAQmx - Data Acquisition VIs Help

1. Unpack the Module and Accessories

The switch module is shipped in an antistatic package to prevent
electrostatic damage (ESD) that can damage several components
in the module.

A Caution Never touch the exposed pins of connectors.

To avoid such damage when you handle the module, take the following
precautions:

*  Ground yourself using a grounding strap or by holding a grounded
object.

*  Touch the antistatic package to a metal part of the chassis before you
remove the module from the package.

Remove the module from the package and inspect the module for loose
components or any sign of damage. Notify NI if the module appears
damaged in any way. Do not install a damaged module in the chassis.

Store the module in the antistatic package when the module is not in use.
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2. Verify the Components

NI Switches Getting Started Guide

Make sure you have the following items:

a

a
a
a

NI-DAQ 7.x software and documentation package
The specifications document for your NI switch module
1/8 in. flathead screwdriver

For development, at least one of the following software packages and
documentation:

— LabVIEW

- LabWindows™/CVI™

—  Microsoft Visual C++

—  Microsoft Visual Basic

PXT switch modules require the following:

a
a

PXI switch module

PXIT chassis or PXI/SCXI combination chassis

SCXIT switch modules require the following:

a

a
a
a
a

Switch Controller (NI 4021/4060/4070 or E Series device)
Cable adapter

Cable

SCXI switch module

SCXI chassis or PXI/SCXI combination chassis
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3. Install the Software

National Instruments switch modules are packaged with NI-DAQ 7.x.
This driver software package contains three drivers as well as an extensive
library of functions and VIs you can call from your application software,
such as LabVIEW or LabWindows/CVI, to program your NI switch
module. The NI-DAQ 7.x driver software has an application programming
interface (API), which is a library of functions, classes, VIs, attributes, and
properties for creating applications for your device.

Confirm the Application Software Version

You must use NI application software (LabVIEW, LabWindows/CVI,
or Measurement Studio) version 7.x or later with NI-DAQmx. The
NI-SWITCH API supports LabVIEW 6.1, LabVIEW 7.x, and
LabWindows/CVI 5.5 and later. Install or upgrade your application
software before installing the driver software.

Uninstall NI-DAQ 6.9.3 or Earlier

If you are upgrading from NI-DAQ 6.9.3 or earlier, you must uninstall the
software before installing NI-DAQ 7.x. Some NI-DAQ devices supported
in 6.9.3 may no longer be supported. Before uninstalling NI-DAQ 6.9.3 or
earlier, refer to the DAQ Quick Start Guide, available on the NI-DAQ 7.x
Device Documentation CD, for details.

NI-DAQ 7.x cannot exist on the same system with earlier versions of
NI-DAQ. When you install NI-DAQ 7.x, the latest version of Traditional
NI-DAQ replaces earlier versions of NI-DAQ and any support files
installed by the earlier version. Earlier versions of NI-DAQ are removed
when you install NI-DAQmx.

Insert the NI-DAQ 7.x CD

A Caution Do not install NI-DAQ 7.x if your existing applications include unsupported
devices. Refer to the DAQ Quick Start Guide, available on the NI-DAQ 7.x Device
Documentation CD, for details.

Insert the NI-DAQ 7.x CD. The NI-DAQ 7.x installer should open
automatically. If not, select Start>Run. Enter x: \setup. exe,

where x is the letter of the CD drive. For troubleshooting and operating
system-specific instructions, refer to the Hardware Installation Wizard
atni.com/support/install.

@ Tip Install your driver software before installing the switch module to ensure proper
installation and to avoid warnings about driver installation asking you to install the driver.
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Select an API

NI-DAQ 7.x includes three drivers, each with its own API.

e Traditional NI-DAQ is an upgrade of the earlier version of NI-DAQ.
Traditional NI-DAQ has the same VIs and functions and works the
same way as NI-DAQ 6.9.3, except that you can use Traditional
NI-DAQ and NI-DAQmx on the same computer.

¢ NI-DAQmx is the latest NI-DAQ driver with new VIs, functions,
and development tools for programming switch modules as well as

E Series and other SCXI modules.

e NI-SWITCH 2.x is the latest NI-SWITCH driver with new Vls,
functions, and development tools for programming switch modules.
NI-SWITCH is a driver layer on top of the NI-DAQmx and Traditional
NI-DAQ drivers. NI-SWITCH is an IVI-compliant instrument driver

that supports all NI switch modules.

Refer to Table 1 to determine which APIs work with your switch module.

Table 1. Switch Module API Support

NI-DAQmx Traditional NI-SWITCH
Module API NI-DAQ API 2x API
NI SCXI-1160/1161/1163R v v v
All other SCXI switch modules v — v
NI PX1-2501/2503/2565/2590/2591 — — v
All other PXI switch modules v — v

Install Support Files

The NI-DAQ 7.x installer detects the NI software installed on the system
and automatically selects the latest versions of the driver, application
software, and language support files from the CD.

Verify that the installer detected and selected the correct support files and
the correct version number of the application software and/or language.

You can select additional options to install the support files, examples, and
documentation. Follow the software prompts.

@ Note If you install NI-DAQ 7.x before installing your NI application software version 7.x
or later, you must run the NI-DAQ 7.x installer again to install the correct application
software support. Select Start»Run. Enter x: \setup. exe, where x is the letter of the

CD drive.
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4. Install the PXI Switch Modules

To install a PXI module, complete the following steps:

1. Power off and unplug the PXI chassis. Follow proper ESD precautions
to ensure you are grounded before installing the hardware.

2. Remove the filler panel of an unused PXI slot.
Touch any metal part of the chassis to discharge static electricity.

4. Insert the device into the PXI slot. Use the injector/ejector handle to
fully insert the device.

5. Screw the device front panel to the chassis front panel mounting rail.

1 PXIl or PXI/SCXI Combination Chassis 3 Screws
2 PXI Switch Module 4 Injector/Ejector Handle

Figure 1. Installing a PXI Switch Module

© National Instruments Corporation 7 NI Switches Getting Started Guide



5. Install the SCXI Switch Modules

Rear Connectors

SCXI switches have two types of rear connectors that differentiate their
cabling schemes: a 10-pin and a 50-pin. Refer to Table 2 and look at the
back of the switch module to determine how many pins are on the rear

connector.

f—ti
loe |

loe |

1
2

High-Voltage Analog Bus (HVAB)
10-pin Rear Connector

3 50-pin Rear Connector

SCXI Controllers

Figure 2. SCXI Switch Module Rear Connectors

SCXI switch modules require a controller. Before installing an SCXI
switch module, refer to Table 2 to ensure that your controller supports your
switch. Table 2 also lists the cable adapter kit(s) necessary to cable the
controller directly to the switch module.

Table 2. SCXI Controllers and Supported SCXI Switches

SCXI Switch Controllers

C0§;::t0r Switch Module NI 4021 NI 4060 NI 4070 E Series
10-pin SCXI-1127 SCXI-1359 kit | SCXI-1357 kitor | SCXI-1357 kitor | Can control but not
SCXI-1358 kitor | SCXI-1358 kitor | cable directly to
SCXI-1128 SCXI-1359 kit | SCXI-1359 kit switch module?
SCXI-1129
SCXI-1130 Not supported!
SCXI-1166
SCXI-1167
SCX1-1193

NI Switches Getting Started Guide
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Table 2. SCXI Controllers and Supported SCXI Switches (Continued)

Rear
Connector

SCXI Switch Controllers

Switch Module NI 4021 NI 4060 NI 4070 E Series

50-pin

SCXI-1160 SCXI-1362 kit | SCXI-1362 kit SCXI-1362 kit SH6868-EP and

SCXI-1349
SCXI-1161

SCXI-1163R

SCXI-1190

SCXI-1191

SCXI-1192

I 'The NI 4060 cannot control the SCXI-1130/1166/1167 or SCXI-1193 switch modules. For software support information,
refer to Table 3.

2 An E Series device can control these switches when cabled to another SCXI module in the same chassis. The cabled SCXI
module can be an SCXI signal conditioning device or other SCXI switch module. Alternatively, you can install the E Series
device in the rightmost PXI slot of a PXI-1010 or PXI-1011 chassis.

Install and configure the controller as described in its documentation. Refer
to the DAQ Quick Start Guide for installing an E Series or NI 4021 device
and the NI Digital Multimeters Getting Started Guide for installing the
NI 4060/4070.

Installation

After you have installed and configured the controller, refer to the
flowchart in Figure 3 for your next steps.

© National Instruments Corporation 9 NI Switches Getting Started Guide



Refer to
Procedure 1

Are you installing the SCXI
switch in an existing system?

Are you installing
the SCXI switch into
an SCXI-1000 or
SCXI-1001 chassis?

Refer to <
Procedure 2

No (You have a PXI-1010/1011)

Is the controller
in the rightmost slot of the
same chassis?

Yes _ |Refer to
Procedure 3

Do you have a Yes

PXI-1010 chassis?

No (You have a PXI-1011)

Refer to
Procedure 4

Figure 3. SCXI Switch Module Installation Flowchart
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Procedure 1: Installing the SCXI Switch in an Existing System

If your SCXI system already has a controller established and the controller
supports your switch, you can simply add additional SCXI switch modules
in any available SCXI slots. Refer to Table 2 to determine if your controller
supports your SCXI switch module.

1. Power off and unplug the SCXI chassis. Follow proper ESD
precautions to ensure you are grounded before installing the hardware.

2. Remove the filler panel in an unused SCXI slot.
3. Touch any metal part of your chassis to discharge static electricity.
4. Insert the switch module into the SCXI slot.
5.  Screw the device front panel to the chassis front panel mounting rail.
1 Any New NI SCXI Switch Module 3 Any SCXI Chassis
2 Existing SCXI Module 4 Existing Controller

Figure 4. Installing an SCXI Switch Module in an Existing System
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Procedure 2: Cable the Controller to the SCXI Switch

If you are using an SCXI-1000/1001 or PXI-1010 chassis, complete the
following steps:

1. Power off and unplug the SCXI chassis. Follow proper ESD
precautions to ensure you are grounded before installing the hardware.

2. Set the chassis address switches to OFF. In Figure 5, all switches are
shown in the OFF position.

@ Note Older chassis use jumpers inside the front panel, instead of chassis address

switches. Older chassis also differ in fuses and AC power selection. Refer to the chassis
documentation for more information.

3. Confirm the correct power settings (100, 120, 220, or 240 VAC).

4. Connect the power cord.

Front Back

RESET

! 5/ 0w
I 4 0|94
\ 3| 0|x
' 2| 0|8
1. 0=
. ON—
1 Chassis Address Switches 3 Power Settings
2 Chassis Power Switch 4 Power Cord Connector

Figure 5. Chassis Preparation

NI Switches Getting Started Guide 12 ni.com



After you have prepared your chassis, complete the instructions appropriate
to your controller. Refer to Table 2 to determine if your controller supports
and connects to your SCXI switch module.

E Series

E Series devices can directly cable only to switches with 50-pin rear
connectors. Refer to Table 2 to determine if your switch module has a
50-pin rear connector.

1.

A T

~

Power off and unplug the SCXI chassis. Follow proper ESD
precautions to ensure you are grounded before installing the hardware.

Remove the filler panel in an unused SCXI slot.

Touch any metal part of your chassis to discharge static electricity.
Insert the device into the SCXI slot.

Screw the device front panel to the chassis front panel mounting rail.

Attach the SCXI-1349 cable adapter to the rear of the SCXI switch
module.

Screw the cable adapter to the chassis cable adapter mounting rail.

Connect one end of the SH6868 cable to the SCXI-1349 cable adapter
and the other to the E Series device.

1 SCXI Switch

3 SCXI-1349 Cable Adapter

2 SCXI-1000/1001 or PXI-1010 Chassis 5 SH6868 Cable

4 E Series Device

© National Instruments Corporation
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NI 4021/4060/4070

Complete the following steps based on the rear connector of your switch
module. Refer to Table 2 to determine how many pins are on the rear
connector of the switch module.

SCXI Switch with 10-Pin Rear Connector

1.

SANEAE S

Power off and unplug the SCXI chassis. Follow proper ESD
precautions to ensure you are grounded before installing the hardware.

Remove the filler panel in an unused SCXI slot.

Touch any metal part of your chassis to discharge static electricity.
Insert the device into the SCXT slot.

Screw the device front panel to the chassis front panel mounting rail.

Attach the SCXI-1359 cable adapter, included with SCXI-1357/1358
and SCXI-1359 kits, to the rear of the SCXI switch module. Ensure
that the 10-pin connector of the switch module, shown in Figure 2,
connects to the lower right 10-pin connector of the SCXI-1359 (facing
the back).

Screw the cable adapter to the chassis cable adapter mounting rail.

Connect one end of the SHOIMD-AUX cable to the SCXI-1359 cable
adapter and the other to the NI 4021/4060/4070.

vay /4

N

1 SCXI Switch

3 SCXI-1359 Cable Adapter

2 SCXI-1000/1001 or PXI-1010 Chassis 5 SHO9MD-AUX Cable

4 Controller

Figure 7. Cabling an NI 4021/4060/4070 to a 10-Pin Rear Connector Switch Module

NI Switches Getting Started Guide
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SCXI Switch with 50-Pin Rear Connector

1. Power off and unplug the SCXI chassis. Follow proper ESD
precautions to ensure you are grounded before installing the hardware.

2. Remove the filler panel in an unused SCXI slot.

3. Touch any metal part of your chassis to discharge static electricity.

4. Insert the device into the SCXI slot.

5. Screw the device front panel to the chassis front panel mounting rail.

6. Attach the SCXI-1362 cable adapter to the rear of the SCXI switch
module.

7. Screw the cable adapter to the chassis cable adapter mounting rail.

Connect one end of the SHIMD-AUX cable to the SCXI-1362 cable
adapter and the other to the NI 4021/4060/4070.

1 SCXI Switch 4 Controller
2 SCXI-1000/1001 or PXI-1010 Chassis 5 SH9MD-AUX Cable
3 SCXI-1362 Cable Adapter

Figure 8. Cabling an NI 4021/4060/4070 to a 50-Pin Rear Connector Switch Module

© National Instruments Corporation 15 NI Switches Getting Started Guide



Procedure 3: Controller in the Rightmost PXI Slot

You can control your SCXI switches without additional cabling by
installing your controller in the rightmost PXI slot of a PXI-1010 or
PXI-1011 chassis. Refer to Table 2 to determine if your controller supports
your SCXI switch module. Complete the following steps:

NI Switches Getting Started Guide

1.

® N ok

Power off and unplug the PXI chassis. Follow proper ESD precautions
to ensure you are grounded before installing the hardware.

(PXI-1010 only) Set the chassis address switches to OFF. All switches
in the OFF position are shown in Figure 5.

Confirm the correct power settings of the chassis (100, 120, 220,
or 240 VAC).

Connect the chassis power cord.

Remove the filler panel in an unused SCXI slot.

Touch any metal part of your chassis to discharge static electricity.
Insert the device into the SCXI slot.

Screw the device front panel to the chassis front panel mounting rail.

©

1

2 PXI-1011 Chassis

PXI-1010 Chassis 3 Controller

Figure 9. Controller in Rightmost PXI Slot
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Procedure 4: Controller Not in Rightmost PXI Slot of PXI-1011

If you do not install the SCXI controller in the rightmost PXI slot of
the PXI-1011 chassis, you can control the SCXI switches using the
SHOMD-AUX cable. Refer to Table 2 to determine if your controller
supports and connects to your SCXI switch module.

1. Power off and unplug the PXI chassis. Follow proper ESD precautions
to ensure you are grounded before installing the hardware.

2. Confirm the correct power settings of the chassis (100, 120, 220,
or 240 VAC).

3. Connect the chassis power cord.
4. Remove the filler panel in an unused SCXI slot.
5. Touch any metal part of your chassis to discharge static electricity.
6. Insert the device into the SCXI slot.
7.  Screw the device front panel to the chassis front panel mounting rail.
8. Connect the SHOMD-AUX cable to the rear of the PXI-1011 chassis.
Front
e T B I B I I B I =
ey ]
o | iy
Pl i\ < (0] (0] (0] (0] (0] (0] [0} [0}
Rear ?
E """ @ @ @
Yo m ¢
1 PXI-1011 Chassis 2 SHOMD-AUX Cable

Figure 10. Cabling the Controller to the Back of a PXI-1011 Chassis
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6. Configure the PXI Switch Modules

NI-DAQmx

NI Switches Getting Started Guide

In Measurement & Automation Explorer (MAX), configure each

PXT switch module you installed. Configuring the switch modules in
MAX establishes the default settings for the switch module. The
PX1-2501/2503/2565/2590 and PXI-2591 must be configured under

PXI System while all other PXI switches are configured under NI-DAQmx

Devices.

1. Power on the chassis.

2. Double-click the Measurement & Automation icon on the desktop to
open MAX.
Expand Devices and Interfaces.

4. Check that your PXI switch module appears under Devices and
Interfaces.
If your device does not automatically appear, press <F5> to refresh
the view in MAX. If the device is still not recognized, refer to
ni.com/support/install for troubleshooting information.

1. Right-click the switch name and select Properties. Be sure to click the

device name under NI-DAQmx Devices.

¥ PXI-2566: "2566_12" - Measurement & Automation Explorer

File Edt Wiew Tools Help

Configuration Rl E&'Properti
EI@ My Syskemn

g Marme
ﬁ Datka Neighborhood Serial I
2B Devices and Interfaces ESDCkEt

[-{E8 Traditional NI-DAG Devices Y ks tur
[#-PXE PRI System O (Unidentified) gmemnr‘;
-{m WI-DAGm:x Devices Y memar,
_ 15 MwraLe
L[ NI 4021 For PXT: "0 “e& Self-Test EY et sl
..... scxI-1001; "ching [ Test Parels. [er che
SC¥1-1001: "ChID: ‘; Reset Device
-[B8 GPIBO (PCI-GPIE)
[]___;i,;l* Ports (Serial & Parallel Rename
- IV Instruments 7 Delete
-8 Scales 5y Properties. .

Figure 11. Configuring Switch Modules Under NI-DAQmx Devices in MAX
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PXI System

5

PXT System.

Configure the module properties.

*  (Optional) Select the terminal block/accessory from the
Terminal Block/Accessory list box.

*  Set the default topology of the switch module by selecting
a topology from the Topology list box.

Click OK to accept the changes.

You can perform a self-test on switches listed under NI-DAQmx
Devices. Right-click the switch you want to test.

Select Self-Test to test the selected device.

When the self-test finishes, a message indicates if an error occurred.
If an error occurs, refer to ni . com/support/install for
troubleshooting information.

Right-click the switch name and select Properties. Be sure to click the
device name under PXI System.

Note Only the PXI-2501/2503/2565/2590 and PXI-2591 can be configured under

¥ PX14::12::INSTR [MI 2591] - Measurement & Automation Explorer

File Edit “iew Toolz Help

Configuration B3 Properties

ol

Eg by Spztem Hems

E Data Meighborhood m

|_-‘_| Devices and Interfaces WISA Alias
-8 Traditional MI-DAQ Devices Pl Bus Mun
|_:_|PXI Pl Systemn [Unidentified) PCI Device |
E|4¥j€ Pl Bridge (N1-p:1-3) PCl Functior
(- Chassis 1 [F1-1008) M anufacture
ﬁ Pl4:10:INS TR [FrI-6533) adel Mame

/ Canfigure Switch
....E F‘><I4 13:INSTR [FXI-E5

.....g Pild::14:INSTR [P1-25
A PI4:15:INSTR [FI-65
AR P33 INSTR (PI-256
A P 30N TR (FRI-B5] =
B P31 3:INSTR (F-25( 52

[VElEtE
Rename

##4 Dpen VIS4 Session

Properties

T TToF H =
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Figure 12. Configuring Switch Modules Under PXI System in MAX
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2. Configure the module properties.

*  (Optional) Select the terminal block/accessory from the
Terminal Block/Accessory list box.

*  Set the default topology of the switch module by selecting a
topology from the Topology list box.

3. Click OK to accept the changes.

7. Configure the SCXI Switch Modules

In MAX, configure each SCXI switch module you installed. SCXI switches
can be configured under NI-DAQmx Devices and/or Traditional NI-DAQ
Devices. Configuring the switch modules in MAX establishes the default
settings for the switch module.

Refer to Table 3 to determine your MAX configuration options according
to your controller. For example, the NI 4021 can control a switch module
configured under NI-DAQmzx Devices or Traditional NI-DAQ Devices.
The NI 4060 can only control SCXI switch modules configured under
Traditional NI-DAQ Devices.

Table 3. Switch Module Configuration in MAX by Controller

SCXI-1130/1166/1167/1193 All Other SCXI Switch Modules
Controller Can Be Configured Under Can Be Configured Under
NI 4021 NI-DAQmx Devices NI-DAQmx Devices/
Traditional DAQ Devices
NI 4060 — Traditional DAQ Devices
NI 4070 NI-DAQmx Devices Traditional DAQ Devices
E Series NI-DAQmx Devices NI-DAQmx Devices/

Traditional DAQ Devices

NI-DAQmx

If you are using NI-DAQmzx, complete the following steps, as shown in the
figures, to configure the SCXI chassis and switch module.

1. Right-click NI-DAQmx Devices in the configuration tree and select
Create New NI-DAQmx Device.

2. Select NI-DAQmx SCXI Chassis and choose the chassis.

Select the controller cabled to the communicating SCXI module from
Chassis Communicator. If MAX detects only one DAQ device, the
device is chosen by default, and this option is disabled.

NI Switches Getting Started Guide 20 ni.com



4. Select the module slot connected to the chassis communicator from
Communicating SCXI Module Slot.

5. Enter the chassis address setting in Chassis Address. Make sure the
setting matches the address setting on the SCXI chassis.

6. Select whether or not to auto-detect SCXI modules. If you do not
auto-detect modules, MAX disables the Communicating SCXI
Module Slot.

7. Click Save.

Create Mew SCXI Chassis : il

hassis Communicator
MI 4021 for PXI: "Deva" s

Zomrunicating SCXI Module Slot
ISeIect. . vl

Chassis &ddress
o

W Auto-Detect Modules in Chassis

Save | Cancel Help |

Figure 13. Configuring SCXI Switch Modules Under NI-DAQmx Devices

8. The SCXI Chassis Configuration window opens. The Modules tab is
selected by default. If you did not auto-detect modules, select an SCXI
module from the Modules list box. Be sure to locate the module in the
correct slot.

SCXI Chassis Configuration Xl

Modules | Chassis |

Slot Modules Device Mame Accessar

[1 [scuriinz =] |5ciMadi Mane | Detais...
[ [peuriten =] [scimodz Mone =] Details...
[ [scuriies =] sc1mads Mane | Detals...
[« [scuriiz =] [actmads Mone =] Detais...
Auto-Detect All Modules Ok Cancel Help

Figure 14. Configuring SCXI Switch Modules Under NI-DAQmx Devices
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9. MAX provides a default name for the Device Name field. To change

the name, click in the field and enter a unique alphanumeric ID for the

SCXI module.

API and is the resource name for the NI-SWITCH API.

Note The text in the Device Name column is the name you reference in the NI-DAQmx

10. If you are using a connected accessory, such as a terminal block, select

it from Accessory.
11.
12.

Click Details to configure the switch module options.

The switch module configuration window opens. The Terminal

Block/Accessory tab is selected by default. Select the terminal block
connected to the switch module from the Terminal Block/A ccessory

list box.

13. Set a default topology from the Topology list box.

Note The SCXI-1127/1128 can connect to the high-voltage analog bus (HVAB) during

scanning. You can configure the switch to automatically connect to the HVAB during
scanning by selecting an optional checkbox (not shown) on the previous window.

NI Switches Getting Started Guide

Details: SCXI-1160 1160_3_1

Terminal Block/Topalogy | Channelz I

Terminal Block/accessary

| Mone =l
Topology
| 1160{16-5PDT |
OF. I Cancel | Help |

Figure 15. Configuring SCXI Switch Modules Under NI-DAQmx Devices
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14. Click the Channels tab.

15. Designate source channels for the topology selected in the Terminal
Block/Topology tab. You can set different source channels for each
topology.

16. Designate reserved for routing channels. You can reserve different
channels for routing in each topology.

17. Click OK.

18. Repeat steps 11 through 17 to configure additional SCXI switch
modules.

19. If you need to change any chassis settings, click the Chassis tab.

20. Click OK to accept and save the settings for this chassis.

@ Note You cannot save the chassis configuration until you finish entering module
information. A message at the top of the SCXI Chassis Configuration window alerts you
of the status of the configuration. You cannot save if an error appears in the message box.
If a warning appears in the message box, you can save the configuration.

21. Right-click the chassis name in the NI-DAQ API you want to test
under Devices and Interfaces.

22. Select Test. If the test fails, a message explains the failure.

Traditional NI-DAQ

If you are using Traditional NI-DAQ, complete the following steps, as
shown in the figures, to configure the SCXI chassis and switch module.

1. Right-click Traditional NI-DAQ Devices in the configuration tree
and select Add SCXI Chassis.
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2. Select SCXI Chassis. Click Next.

Add 5CXI Device

o
] ) ]

Figure 16. Adding an SCXI Chassis in MAX

3. Select the type of chassis. Click Next.

Select 5CX1 Chassis

SCxl-1000DC
SCxI1-1001
Fel-1010
Fel-1011

Figure 17. Selecting a Chassis Type in MAX

4. Select an ID for the SCXI chassis. The ID can be any integer between
1 and 3,200. Use this ID to identify the chassis in your application.
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5. Enter the chassis address setting. Make sure the setting matches the
chassis address setting on the SCXI chassis. Refer to the Procedure 2
section for help locating the chassis address switches. Click Next.

Figure 18. Configuring the Chassis ID and Address in MAX

6. Select whether or not to auto-detect SCXI modules. Click Next.

SCH Auto-Detect

Figure 19. Auto-Detecting Modules
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7.

Select the controller which acts as the communication path between
the chassis and the computer. Click Next.

Select 5CX1 Communication Path

Select the communication path

Select the communication path

" e | [or
M1 4060 for Pl

Device 2: between your chassiz and the
Device 3: F<1-6533 computer

Device 4 Pl-BR33

Device & Pl-B533

Device 18: Pl-B533

Cancel

¢ Back I Mest > I

Figure 20. Select the Controller

Select the switch module that is cabled to the communication device.
If the chassis has only one module, NI-DAQ selects the module by
default.

Click Finish to accept the settings.

2] x|

SCH¥I Auto-detection Results

MHI-DAGQ found the following modules in your chassis:

1: 5011160

These modulzs will be added
automatically to your chassis in
multiplexed mode with default
zettings.

Before pou click the finish button,
you must specify which module iz
cabled to the communication
device by clicking on the module in
the ligt bow,

< Back I Finish I Cancel
Figure 21. Select the Cabled Switch Module
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10. Select the chassis from Devices and Interfaces» Traditional NI-DAQ

Devices.

11. Right-click a module slot and select Properties.

File Edit Wiew Tools Help

(¥ Module 1 : SCXI-1127 - Measurement & Automation Exp

Configuration

Elg My Syskem

IE Data Neighborhood

EE Devices and Interfaces

-{@a] Traditional NI-DAG Devices
I MI 4021 for PRI (Device 1)
BB MI 4060 for PXI (Device 2)
B PYI-6533 (Device 18)
- PRI-6533 (Device 3)
-l PRI-6533 (Device 4)

- B PRI-6533 (Device 5)
S [ SCXI-1001 (Chassis 2)
i I-1127

Module 2 1 SCXI-112
Module 3 1 SCHI-112
Module 4 1 SCXI-1125

ZEaEaaEe

ﬁl [ I

— =

— Akkrib

e

Elor

Ly P08
@ Insert...
Delete

Module 5 ¢ SCXI-1128 [

Figure 22. Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX

12. The General tab is selected by default. Choose which controller
connects to the module from the Connected to list box. Select the
check box if the DAQ device controls the chassis.

Configuring SCXI-1129 Module in Ehas:

Gerneral | Arccessomy

Connected to:

| This device will contial the chassiz

o]

Cancel |

Apply |

Figure 23. Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX
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13. Click the Accessory tab (if available). Select the terminal block
connected to the switch module from the Accessory list box.

Configuring SCXI-1129 Module in Ch: 21|

General Accessony |

Accesson

(0] I Cancel Apply

Figure 24. Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX

14. Click OK to accept the settings.

8. Install the Terminal Blocks and Connect Signals

If your module uses a terminal block, complete the following steps:

1. Wire sensors to your switch module or the terminal block. For signal
connection information, refer to the terminal block installation guide
or the NI Switches Help for more information.

A Caution Always refer to the specifications document included with your switch before
connecting signals. Exceeding specified switch signal ratings can create a shock or fire
hazard and damage any or all of the devices connected to the switch.

A Caution Modules that share a common HVAB derate to their lowest common voltage
rating, even if they do not connect signals to the backplane. Refer to the Derating Modules
That Share the HVAB section for more information.

2. Connect the module front connector to its mating connector on the
terminal block.

3. Tighten the top and bottom thumbscrews on the back of the terminal
block rear panel to hold it securely in place.
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1 Switch Module 4 Signal Wires
2 Thumbscrews 5 Chassis
3 Terminal Block

Figure 25. Installing a Terminal Block

Derating Modules That Share the HVAB

As a safety precaution, modules that share a common HVAB must be
derated to their lowest common voltage rating, even if they do not connect
signals to the backplane. Refer to Figure 2 to determine if your switch has
an HVAB connector. The following examples demonstrate how to derate
your modules.

Example 1

SCXI-1000 chassis

SCXI-1359 2-slot backplane adapter behind slots 3 and 4
SCXI-1127 (250 V, CAT II) in slot 4

SCXI-1129 (150 V, CATI) in slot 3

Both modules share the HVAB and the SCXI-1127 must not exceed the
rating of the SCXI-1129 (150 V, CAT D).
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Example 2

SCXI-1000 chassis

SCXI-1359 2-slot backplane adapter behind slots 3 and 4
SCXI-1127 (250 V, CAT 1) in slot 4

SCXI-1129 (150 V, CAT I) in slot 2

The SCXI-1127 does not share the HVAB with the SCXI-1129. Therefore,
the SCXI-1127 can operate at the full rating (250 V, CAT II).

Example 3

SCXI-1000 chassis

SCXI-1359 2-slot backplane adapter behind slots 3 and 4
SCXI-1127 (250 V, CAT 1) in slot 4

SCXI-1190 (30 V, CAT I) in slot 3

The SCXI-1190 does not have a HVAB connector. Therefore, the
SCXI-1127 can operate at the full rating (250 V, CAT II).

9. Program the Switch Modules

You can operate the switch module in one of the following three ways.
e Interactively using the NI-SWITCH Soft Front Panel

*  Programming using the NI-SWITCH API

e Programming using the NI-DAQmx API

NI-SWITCH Soft Front Panel (SFP)

NI-SWITCH API

NI Switches Getting Started Guide

The NI-SWITCH SFP is an interactive tool you use to test the basic
functionality of the switch, become familiar with its operation, and
troubleshoot your applications. All NI switches can be operated with
the NI-SWITCH SFP.

You can launch the NI-SWITCH SFP from Program Files»National
Instruments»NI-SWITCH»NI-SWITCH Soft Front Panel.

The NI-SWITCH API includes a set of operations and attributes that use all
the functionality of the switch, including configuration, control, and other
module-specific functions. All NI switches can be programmed with
NI-SWITCH.
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Information about programming with NI-SWITCH is available in the
NI Switches Help. This help file contains measurement tasks, concepts,
a detailed function/VI reference for NI-SWITCH 2.0, and information
specific to your switch module.

For example locations, refer to Programming»Getting Started with
NI-SWITCH in the NI Switches Help at Program Files»National
Instruments»Documentation»NI Switches Help.

NI-DAQmx API

You can operate some switch modules with the NI-DAQmx APL
NI-DAQmx is particularly useful for multimodule scanning operations.
Refer to Table 1 to determine if you can program your switch with the
NI-DAQmx API.

Information about programming with the NI-DAQmx API is available
in the NI-DAQmx Help. Information specific to your switch module is
available in the NI Switches Help.

For example locations, refer to the DAQ Quick Start Guide.

Technical Support Resources

NI Web Support

National Instruments Web support is your first stop for help in solving
installation, configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni . com.

A DoC is our claim of compliance with the Council of the European
Communities using the manufacturer’s declaration of conformity. This
system affords the user protection for electronic compatibility (EMC)
and product safety. You can obtain the DoC for your product at
ni.com/hardref .nst. If your product supports calibration, you can
obtain the calibration certificate at ni.com/calibration.
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Worldwide Support

National Instruments has offices located around the world to help address
your support needs. You can access our branch office Web sites from the
Worldwide Offices section of ni.com. Branch office Web sites provide
up-to-date contact information, support phone numbers, email addresses,
and current events.

If you have searched the technical support resources on our Web site and
still cannot find the answers you need, contact your local office or National
Instruments corporate. For telephone support in the United States, dial
512795 8248. For telephone support outside the United States, contact
your local branch office:

Australia 1800 300 800, Austria 43 0 662 45 79 90 0,

Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599,

Canada (Calgary) 403 274 9391, Canada (Montreal) 514 288 5722,
Canada (Ottawa) 613 233 5949, Canada (Québec) 514 694 8521,
Canada (Toronto) 905 785 0085, Canada (Vancouver) 514 685 7530,
China 86 21 6555 7838, Czech Republic 420 2 2423 5774,
Denmark 45 45 76 26 00, Finland 385 0 9 725 725 11,

France 33 0 1 48 14 24 24, Germany 49 0 89 741 31 30,

Greece 30 2 1042 96 427, India 91 80 51190000,

Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970,
Korea 82 02 3451 3400, Malaysia 603 9131 0918,

Mexico 001 800 010 0793, Netherlands 31 0 348 433 466,

New Zealand 0800 553 322, Norway 47 0 66 90 76 60,

Poland 48 0 22 3390 150, Portugal 351 210 311 210,

Russia 7 095 783 68 51, Singapore 65 6226 5886,

Slovenia 386 3 425 4200, South Africa 27 0 11 805 8197,

Spain 34 91 640 0085, Sweden 46 0 8 587 895 00,

Switzerland 41 56 200 51 51, Taiwan 886 2 2528 7227,

Thailand 662 992 7519, United Kingdom 44 0 1635 523545

CVI™_ V™, LabVIEW™, Measurement Studio™, National Instruments™, NI™, ni.com™, NI-DAQ™,
and SCXI™ are trademarks of National Instruments Corporation. Product and company names

mentioned herein are trademarks or trade names of their respective companies. For patents covering

National Instruments products, refer to the appropriate location: Help»Patents in your software,
the patents. txt file on your CD, or ni . com/patents. 323131B-01 Sepos

©2003 National Instruments Corp. All rights reserved.
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